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WARNING: TO PREVENT FIRE OR
SHOCK HAZARD, DO NOT EXPOSE
THIS EQUIPMENT TO RAIN OR
MOISTURE.

IMPORTANT NOTICE

(For U.S.Model)

The serial number for this equipment is located
on the bottom of the unit. Please write this serial
number on your enclosed warranty card and
keep it in a secure area. This is for your security.

which the receiver is connected.
e Consult the dealer or an experienced
radio/TV technician for help.

INFORMATION TO USER
Alteration or modifications carried out
without appropriate authorization may
invalidate the user’s right to operate
the equipment.

CAUTION:

This product satisfies FCC regulations when
shielded cables and connectors are used to
connect the unit to other equipment. To prevent
electromagnetic interference with electric
appliances such as radios and televisions, use
shielded cables and connectors for connections.

NOTE:

This equipment has been tested and found
to comply with the limits for a Class A
digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to
provide reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses, and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications. However, there is
no guarantee that interference will not
occur in a particular installation. If this
equipment does cause harmful interference
to radio or television reception,which can
be determined by turning the equipment off
and on, the user is encouraged to try to
correct the interference by one or more

of the following measures:

» Reorient or relocate the receiving
antenna.

 Increase the separation between the
equipment and receiver.

e Connect the equipment into an outlet
on a circuit different from that to

CAUTION:

e Use of controls or adjustments or
performance of procedures other than
those specified herein may result in
hazardous radiation exposure.

e The use of optical instruments with
this product will increase eye hazard.

THE ON/OFF SWITCH IS SECONDARY
CONNECTED AND THEREFORE DOES
NOT SEPARATE THE UNIT FROM
MAINS POWER IN STANDBY
POSITION.

CAUTION: TO PREVENT ELECTRIC
SHOCK, DO NOT USE A (POLARIZED)
PLUG WITH AN EXTENSION CORD,
RECEPTACLE OR OTHER OUTLET
UNLESS THE BLADES CAN BE FULLY
INSERTED TO PREVENT BLADE
EXPOSURE.

ATTENTION: POUR PREVENIR LES
CHOCS ELECTRIQUES NE PAS
UTILISER CETTE FICHE POLARISEE
AVEC UN PROLONGATEUR, UNE PRISE
DE COURANT OU UNE AUTRE SORTIE
DE COURANT, SAUF SI LES LAMES
PEUVENT ETRE INSEREES A FOND
SANS EN LAISSER AUCUNE PARTIE A
DECOUVERT.

future reference.

Please read through these operating instructions so you will know how to operate your model
properly. After you have finished reading the instructions, put them away in a safe place for
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IMPORTANT

READ INSTRUCTIONS — All the safety and
operating instructions should be read before the
product is operated.

RETAIN INSTRUCTIONS - The safety and
operating instructions should be retained for
future reference.

HEED WARNINGS - All warnings on the product
and in the operating instructions should be
adhered to.

FOLLOW INSTRUCTIONS — All operating and use
instructions should be followed.

CLEANING — Unplug this product from the wall
outlet before cleaning. The product should be
cleaned only with a polishing cloth or a soft dry
cloth. Never clean with furniture wax, benzine,
insecticides or other volatile liquids since they
may corrode the cabinet.

ATTACHMENTS - Do not use attachments not
recommended by the product manufacturer as
they may cause hazards.

WATER AND MOISTURE — Do not use this
product near water — for example, near a bathtub,
wash bowl, kitchen sink, or laundry tub; in a wet
basement; or near a swimming pool; and the like.
ACCESSORIES - Do not place this product on an
unstable cart, stand, tripod, bracket or table. The
product may fall, causing serious injury to a child
or an adult, and serious damage to the product.
Use only with a cart, stand, tripod, bracket or
table recommended by the manufacturer, or sold
with the product. Any mounting of the product
should follow the manufacturer’s instructions, and
should use a mounting accessory recommended
by the manufacturer.

CART - A product and cart combination should be
moved with care. Quick stops, excessive force,
and uneven surfaces may cause the product and
cart combination to overturn.

VENTILATION - Slots and openings in the cabinet
are provided for ventilation and to ensure reliable
operation of the product and to protect it from
overheating, and these openings must not be
blocked or covered. The openings should never be
blocked by placing the product on a bed, sofa, rug,
or other similar surface. This product should not be
placed in a built-in installation such as a bookcase
or rack unless proper ventilation is provided or the
manufacturer’s instructions have been adhered to.
POWER SOURCES - This product should be
operated only form the type of power source
indicated on the marking label. If you are not sure of
the type of power supply to your home, consult
your dealer or local power company.

CAUTION

RISK OF ELECTRIC SHOCK

DO NOT OPEN

CAUTION:

TO PREVENT THE RISK OF
ELECTRIC SHOCK, DO NOT
REMOVE COVER (OR BACK).

NO USER SERVICEABLE PARTS
INSIDE.REFER SERVICING TO
QUALIFIED SERVICE PERSONNEL.

IMPORTANT SAFETY INSTRUCTIONS

LOCATION — The appliance should be installed in
a stable location.

NON-USE PERIODS — The power cord of the
appliance should be unplugged from the outlet
when left unused for a long period of time.
GROUNDING OR POLARIZATION —

« If this product is equipped with a polarized
alternating current line plug ( a plug having one
blade wider than the other), it will fit into the
outlet only one way. This is a safety feature. If
you are unable to insert the plug fully into the
outlet, try reversing the plug. If the plug should
still fail to fit, contact your electrician to replace
your obsolete outlet. Do not defeat the safety
purpose of the polarized plug.

If this product is equipped with a three-wire
grounding type plug, a plug having a third
(grounding) pin, it will only fit into a grounding
type power outlet. This is a safety feature. If you
are unable to insert the plug into the outlet,
contact your electrician to replace your obsolete
outlet. Do not defeat the safety purpose of the
grounding type plug.

POWER-CORD PROTECTION — Power supply cords
should be routed so that they are not likely to be
walked on or pinched by items placed upon or
against them, paying particular attention to cords at
plugs, convenience receptacles, and the point where
they exit the product.

OUTDOOR ANTENNA GROUNDING - If an outside
antenna or cable system is connected to the
product, be sure the antenna or cable system is
grounded so as to provide some protection against
voltage surges and built-up static charges. Article
810 of the National Electric Code, ANSI/NFPA 70,
provides information with regard to proper
grounding of the mast and supporting structure,
grounding of the lead-in wire to an antenna
discharge unit, size of grounding connectors,
location of antenna discharge unit, connection to
grounding electrodes, and requirements for the
grounding electrode. See Fig. A.

LIGHTNING — For added protection for this product
during a lightning storm, or when it is left unattended
and unused for long periods of time, unplug it from
the wall outlet and disconnect the antenna or cable
system. This will prevent damage to the product due
to lightning and power-line surges.

POWER LINES - An outside antenna system
should not be located in the vicinity of overhead
power lines or other electric light or power
circuits, or where it can fall into such power lines
or circuits. When installing an outside antenna
system, extreme care should be taken to keep
from touching such power lines or circuits as
contact with them might be fatal.

OVERLOADING - Do not overload wall outlets,
extension cords, or integral convenience
receptacles as this can result in a risk of fire or
electric shock.

The exclamation point within an
equilateral triangle is intended to alert
the user to the presence of important
operating and maintenance (servicing)
instructions in the literature accompanying
the appliance.

OBJECT AND LIQUID ENTRY — Never push
objects of any kind into this product through
openings as they may touch dangerous voltage
points or short-out parts that could result in a fire
or electric shock. Never spill liquid of any kind on
the product.

SERVICING - Do not attempt to service this
product yourself as opening or removing covers
may expose you to dangerous voltage or other
hazards. Refer all servicing to qualified service
personnel.

DAMAGE REQUIRING SERVICE — Unplug this
product from the wall outlet and refer servicing to
qualified service personnel under the following
conditions:

* When the power-supply cord or plug is damaged.
« If liquid has been spilled, or objects have fallen
into the product.

If the product has been exposed to rain or water.
If the product does not operate normally by
following the operating instructions. Adjust
only those controls that are covered by the
operating instructions as an improper
adjustment of other controls may result in
damage and will often require extensive work
by a qualified technician to restore the product
to its normal operation.

If the product has been dropped or damaged in
any way.

When the product exhibits a distinct change in
performance — this indicates a need for service.
REPLACEMENT PARTS — When replacement parts
are required, be sure the service technician has
used replacement parts specified by the
manufacturer or have the same characteristics as
the original part. Unauthorized substitutions may
result in fire, electric shock or other hazards.
SAFETY CHECK — Upon completion of any service
or repairs to this product, ask the service
technician to perform safety checks to determine
that the product is in proper operating condition.
WALL OR CEILING MOUNT — The product should
not be mounted to a wall or ceiling.

HEAT — The product should be situated away from
heat sources such as radiators, heat, registers,
stoves or other products (including amplifiers)
that produce heat.

ANTENNA
LEAD IN WIRE

ANTENNA

DISCHARGE UNIT
(NEC SECTION 810-20)
ELECTRIC

SERVICE f— GROUNDING CONDUCTORS
EQUIPVENT (NEC SECTION 810.21)
GROUND CLAMPS
Fig A POWER SERVICE GROUNDING
9 ELECTRODE SYSTEM

(NEC ART 250. PART H)

NEC — NATIONAL ELECTRICAL CODE
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For customers within the USA and Canada,
FOCUS Enhancements, Inc. warrants this
product against defects in materials or
workmanship as follows:

For a period of TWO years from the date of
purchase, FOCUS Enhancements, Inc. will
repair or replace the unit, at our option,
without charge for parts or labor. After the
period of TWO years, you must pay all parts
and labor charges.

The limited warranty is extended only to

the original purchaser. It does not cover
damage or failure caused by or attributable

to Acts of God, abuse, misuse, improper or
abnormal usage, faulty installation, improper
maintenance, lightning, or other incidences of
excessive voltage, or any repairs or tampering
by other than the FOCUS Enhancements
repair facility. It does not cover replacement
of batteries or other consumable parts,
transportation costs or damage in transit.
This warranty will become void if the serial
number or model number identification has
been wholly or partially removed or erased.
Repair or replacement under the terms of

this warranty do not extend the terms of this
warranty. Repairs or replacement performed
outside of the warranty period will carry a
warranty for 60 days from return shipment.
This warranty can not be modified by an
agent of FOCUS Enhancements, Inc. unless
in written and signed by an officer of FOCUS
Enhancements, Inc.

Should this product prove defective in
workmanship or material, the consumer’s sole
remedies shall be such repair or replacement
provided by the terms of this warranty. Under
no circumstances shall FOCUS Enhancements,
Inc. be liable for any loss or damage, direct,
consequential, or incidental, arising out of the
use of or inability to use this product. Some
states do not allow limitations on how long an
implied warranty lasts or the exclusions or
limitations of incidental or consequential

damages, so the above limitations or exclusions
may not apply to you. This warranty gives you
specific legal rights. You may also have other
rights which vary from state to state.

Before requesting warranty or repair service,
refer to http://www.focusinfo.com/support/, to
review the Trouble Shooting guidelines and
the FAQs.

In the United States or Canada, to obtain
warranty service, call or write the FOCUS
Enhancements, Inc. Technical Support Line
for a Return Material Authorization (RMA)
number. Technical Support can be reached at:

Email: support@FOCUSinfo. com

Telephone: 408-370-9963 8AM — Noon
and 1PM - 5PM (PST), Monday
to Friday (Hint: Mondays tend to
be the busiest)

Fax: 408-866-4859
Address: FOCUS Enhancements, Inc.
1370 Dell Ave.

Campbell, CA. 95008

Please mark the RMA number clearly on

the outside of the package. Include a copy
of your sales receipt, a brief description of
the symptoms, your name, address within
the USA or Canada, phone number and any
special shipping instructions. Then deliver or
ship the product, postage and shipping costs
prepaid, to the address above.

For customers outside the USA or Canada,
A warranty can only be offered through your
dealer or distributor and not through FOCUS
Enhancements directly, for this product.
Please contact your dealer or distributor

for repairs or technical support. Refer to
http://www.focusinfo.com/order-desk

under, “FOCUS Resellers Worldwide”,

for a list of International Dealers and
Authorized Service Centers.
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INTRODUCTION

Thank you for purchasing the Focus
Enhancements FireStore FS-3 DTE DV Video
Disk Recorder for full-size DV camcorders. FS-3
adds a digital disk recorder/player to your
camorder for a powerful acquisition combination.

This User Guide is to be used with software
version 1.2 or higher. See page 25 of this manual
for more information to verify which software
Version you are using.

The purpose of this User Guide is to explain the
features and operation of the FireStore FS-3. You
have also received an FS-3 QuickStart guide which
should be kept for quick future reference. Please
study the contents of this User Guide before
attempting to use your FS-3.

Check the Focus Enhancements website regularly
for updates to software and documentation and if
you have questions or require further assistance
with your FireStore FS-3, please visit:

www.focusinfo.com/support

Alternatively, contact your Focus Enhancements
FireStore dealer/distributor.

PACKAGE CONTENTS

Please take a moment to study the contents of your
FireStore FS-3 package. You should have the
following contents:

* One (1) FireStore FS-3 unit w/ your
selected battery plates (FS-3 V-Mount, FS-3
Anton/Bauer, FS-3 PAG-Lock or FS-3 NP.
The NP version also includes a pair of
captive screws)

 One (1) FireStore FSHDD-1 FireWire Hard
Disk Drive (HDD)*

 One (1) 6-pin to 4-pin Right Angle
FireWire cable.

* One (1) 6-pin to 6-pin Right Angle
FireWire cable.

PAGE 7

* One (1) NP Adapter Plate w/ (4) four mount
screws. (FS-3 NP version only)

e User Guide
e QuickStart Guide

If any of these contents are missing, please
contact Focus Enhancements or your FireStore
dealer/distributor immediately.

You may need to purchase cables to connect more
than one hard disk drive to FireStore FS-3 at a
time. Your Focus Enhancements dealer can help
you identify additional cables you may need.

* Depending on the model number that is ordered,
drive capacity may vary. Please verify that you
have received the correct FireStore FSHDD-1
capacity that you ordered.

WHAT IS A DTE DISK RECORDER?

A DTE DV Disk Recorder is a device that allows
you to record/playback DV video directly to/from
a removable FireWire hard disk drive without
using a computer. Video is input or output as a
DV Video Stream through FireStore which
writes/reads a DV data stream in NLE native file
formats from/to a FireWire hard disk drive.

WHAT IS FIRESTORE FS-3?

FireStore FS-3 is a DTE DV Disk Recorder that
mounts directly to full size DV camcorders. With
FireStore FS-3, it is possible to:

* Input or output DV video from/to DV
camcorders. It is also possible to use it stand-
alone with virtually any DV video device

« Capture clips to hard disk at the acquisition
stage - there is no need to capture later.

« Simultaneously record to disk while recording
to your camcorder’s tape.

« Record clips to disk in DTE Technology
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based “edit-ready” file formats such as Raw
DV, AVI Type 1, AVI Type 2, Matrox AVI,
Canopus AVI, QuickTime and Avid DV-OMF.
This means clips are immediately available to
your NLE system without first having to
transfer or convert the clips.

« Connect your FireWire disk directly to your
computer or connect via FireStore which
allows mount and dismount of the drives
without re-cabling or computer re-boots.

« Jump from clip to clip without spooling
through tape when in playback mode.

« As well as video, record and playback
embedded DV audio in either 2-ch (16-bit,
48kHz) or 4-ch (12-hit, 32kHz) formats.

* Record source timecode from your
camcorder or create your own Free Run,
Regen or Rec Run timecode. It is also possible
to preset timecode and user-hit values.

* Record, play and navigate using FireStore
FS-3’% VTR style controls.

* Record and recall a single frame of DV
video. Also record user definable time-lapse
sequences.

« Slow playback down or speed it up by 1
frame per second increments.

* Use trick playback modes such as up to
30X/-30X fast-forward and rewind speeds,
reverse play, loop clip and loop entire disk.

« Control FS-3 remotely via FireWire (for
triggering record/pause or AV/C) from a DV
based camcorder GPI port. Alternatively, control
FS-3 via RS-232C (using the optional 3.5mm to
DB-9 cable), wired remote or infrared remote
control, all of which are available as accessories.

« Daisy-chain up to four FireWire (IEEE-
1394) hard drives (in addition to the internal

removable FSHDD-1 FireWire hard drive)
together for extremely long, uninterrupted
record times.

BASIC APPLICATIONS

FireStore FS-3 can be used in the acquisition
stage of production, the editing/post production
stage and the presentation stage. FireStore FS-3
is most useful in the following applications:

 Record DV video live to disk at the
acquisition stage. Not only will you have an
exact copy of your camcorder’s tape footage
on disk with the same timecode, audio and
video information, it will be possible to
quickly review shot footage back through your
camcorder without risking damaging the tape
in your camcorder’s tape transport. This
“confidence recording” will save time and
reduce costly re-shoots during production.

« Clips are recorded in DTE Technology

based “edit-ready” file formats such as RawDV,
AVI Type 1, AVI Type 2, Matrox AVI, Canopus
AVI, QuickTime or Avid DV-OMF. This will
allow you to get your footage onto a computer
(Mac or PC) and view or edit it quickly. The
FireStore FSHDD-1 or external FireWire disk
drive can either be connected directly to your
computer (without FireStore) or through
FireStore which allows you to mount/un-mount
any connected drives without re-cabling or re-
booting. This also allows you to capture footage
to disk without tying up your computer.

« Playback DV video clips that were recorded to
a connected FireWire hard disk drive from
FireStore FS-3 to any DV video device such as a
mixer, camcorder or deck. Use FireStore’s
random access capabilities to navigate quickly
from clip to clip without having to spool forward
and backward through tape. Use FireStore FS-3’
trick playback modes such as multi-speed fast
forward, incremental 1 frame per second slow
motion and reverse play to present DV video in
industrial, presentation or scientific applications.
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MOUNTING TO A CAMCORDER 3) Attach the battery to the rear of the FS-3 unit.

The FireStore FS-3 is designed to mount directly
to full size DV camcorders. FireStore FS-3

features either Anton/Bauer, V-Mount, PAG Lock
or NP mount plates allowing quick connection to
most camcorders featuring these battery systems.

Mounting to Anton/Bauer, V-Mount or PAG-
Lock Equipped Camcorders

To mount to camcorder's featuring either an
Anton/Bauer, V-Mount or PAG Lock battery
system, do the following:

Mounting to NP Battery Equipped
1) Remove any connected battery from the Camcorders

camcorder's battery mount plate.

To mount to camcorder's featuring NP battery
systems, do the following:

1) Remove and disconnect the attached
battery system from the camcorder. Consult
either your camcorder's documentation or
documentation from your battery system for
more detailed information on removing the
battery system. Leave any existing rubber
gasket between the camcorder and battery
system in place.

2) Mount the NP adapter plate to the rear of the
camcorder with the supplied four screws (the
plate mounts to the rear of the camcorder

2) Connect the FS-3 unit to the battery mount utilizing the same mount holes the NP battery
plate on the rear of the camcorder. case mounts to).

PAGE 9
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3) FS-3 features a two wire connector with 6) Re-attach the battery system to the rear of
black and red cables that connects main power the FS-3. Ensure to connect all cables and
between the FS-3 and the camcorder. Connect utilize the supplied gasket between FS-3 and
this to the equivalent connector on the rear of the battery system. Harness any loose cables
your camcorder. into the “Hidey-Hole” on the FS-3.

If you are using a digital battery system that CONNECTING A FIREWIRE CABLE

passes battery life status to the camcorder, and are BETWEEN FS-3 AND CAMCORDER
using a camcorder that is compatible with these

systems, connect the following cables between Connect either the 6-pin to 6-pin or 6-pin to 4-

FS-3 and camcorder (FS-3 NP version only:) pin FireWire cable between the FS-3's “DV 1/0”

o port and the camcorder's DV interface.
Anton/Bauer Digital Battery System

- Grey and Orange Cable

IDX Syncron Digital Battery System
- Blue and Red Cable.

4) “Hook” the FS-3 to the adapter plate on the
rear of the camcorder (these hooks are unique
to the FS-3NP model). Insert the supplied
gasket between the plate and the FS-3 unit.
Harness any loose cables into the “Hidey-Hole”
on the FS-3.

5) Once mounted, secure the two captive screws
at the base of the FS-3 to the camcorder. Ensure
that no cables are “pinched” between the FS-3
and the camcorder.
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INSERTING AND REMOVING
FIRESTORE FSHDD-1
FIREWIRE DRIVES

The best way to get to know the FireStore
FSHDD-1 FireWire HDD is by studying
the supplied manual. The manual provides
detailed instructions and illustrations.

INSERTING THE HDD: Insert the drive

into the slot on top of the FS-3 unit. Ensure that
the power switch on the bottom side of the
drive is set to “On” before inserting. The drive
will only insert one way and features a “key”
on one side to prevent incorrect insertion. Press
down on the drive handle firmly until the
handle meets the top of FS-3. If power is on,
you will observe the power LED light up green.
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REMOVING THE HDD: Slide the HDD release

latch on the FS-3 top plate toward the battery
system. Once slid as far as possible, hold the latch
while at the same time grasping the FSHDD-1
drive handle and pulling the HDD out from FS-3.

WARNING: Make sure FS-3 is in STOP mode

before removing the disk drive from the system.
Do not attempt to remove when FS-3 is in REC
or REC-PAUSE mode.

USING EXTERNAL FIREWIRE
DISK DRIVES

In addition to using FireStore FSHDD-1
FireWire HDDs in the internal slot on FS-3, it
is also possible to connect any FireWire disk
drive to the HDD 1/O port on FS-3. Power a
single FireWire disk drive on FS-3 at any
given time (either internal or external). If
external drives are being used as additional
volumes to the inserted FSHDD-1 FireWire
HDD, it will be necessary to provide external
power to these drives. It may also be necessary
to partition and format drives before use with
FS-3. See page 31 of this user guide for
instructions on preparing drives before use.

NOTE: It is possible to “hot swap” both
internal and external FireWire HDDs on FS-3.
Drives can be disconnected and connected from
the system without the need to power cycle the
unit. Ensure that FS-3 is in STOP mode before
removing a disk drive.

PHYSICAL FEATURES

Your FireStore FS-3 features two main surfaces,
the front panel and the rear connector panel.

FRONT PANEL

The front panel contains the backlit LCD
and nine buttons for controlling FireStore’s
functions. The top row of buttons act as Soft
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Keys and provide the function displayed on the
bottom of the LCD.

The front panel also features a tally light,
infrared remote sensor and power switch.

1 =i FOOCUS Enhancements

FireStore. rs-3
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1. Tally Light

The FS-3 red tally light is located at the top of
the FS-3 front panel. In general, this light will
flash when FS-3 is in REC/PAUSE mode and be
solid when in RECORD mode. This light is also
used to warn the user when an error or warning
message appears on the FS-3 LCD display. See
the “FS-3 LCD DISPLAY AND TALLY
MODES” section on page 41 of this User Guide
for more information on tally light status.

2. Power Switch

FireStore FS-3’s power switch is located on the
top left side of the front panel. This switch,
although mechanical, is controlled via
software. When the power switch is set to ON
and then OFF, in most cases the unit will take

a moment to power down. During this time,
FS-3 is ensuring that any files that have not
been closed properly in a record session get
closed. This prevents errors occurring on
particular files.

3. Infrared Remote Sensor

The FS-3 infrared remote sensor

is for use with the optional FS-3 infrared
remote commander. For information on the
FS-3 infrared remote commander, see “FS-3
REMOTE CONTROL COMMANDERS on
page 38 of this User Guide. This port can be
disabled in infrared noisy environments if
desired in the FS-3 settings menu.

4. LCD Display Screen

The FS-3 LCD screen displays status, setup
and warning/error messages relating to FS-3.
The LCD backlight is set as default to ON,
but this can be set to OFF or AUTO-OFF
mode if desired. See page 28 of this User
Guide for details.

5. Keypad Soft Key Function

The bottom line of the FS-3 LCD screen
displays Soft Key functions for the top row
of buttons. Soft Keys allow the function of
the top row of buttons to change depending
on particular modes.

6. Keypad Soft Key

The top row of buttons on the FS-3 front
panel are dedicated Soft Keys. Soft Key
functions change depending on what mode
FS-3 is in. Current Soft Key function is
displayed on the bottom row of the LCD
screen. The left key on the top row of buttons
acts as a Soft Key and as the STOP key during
record sessions. The right key also acts as a
SHIFT key which allows Standard Keys to
have a secondary function.

PAGE 12
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7. Keypad Standard Keys

The bottom two rows of keys on the FS-3
keypad have dedicated functions such as fast
forward/back search, play, record, and index
forward back. Each key (except record) also
has a SHIFT mode which allows a secondary
function to be performed.

LCD DISPLAY

The FS-3 LCD screen displays different FS-3
modes and states. On boot up, FS-3 will
display the following screen:

HELCOME TO
FIRESTORE!

FLERSE WUAIT

Depending on the connected disk drive, FS-3 may
or may not display “Please Wait” during boot up.

Once booted up, if no disk drive is connected to
the FS-3 (either through the internal slot or
externally via the HDD 1/O port), the following
screen will appear:

HO DISK
DETECTED

HEHU

Insert a FireStore FSHDD-1 FireWire HDD

to the internal drive slot or connect a FireWire disk
drive to the HDD 1/O port. If a FSHDD-1
FireWire HDD comes from the factory, it should
be configured and ready to use. If the message
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“No Disk Detected” appears, ensure you have a
FSHDD-1 FireWire HDD inserted properly. If the
message “No Format Detected” appears, you will
first need to partition and format the inserted drive.
FS-3 will prompt you through the steps required to
perform a format. WARNING: Formatting will
erase all data on disk!

Once ready for use, the FS-3 default Splash
Screen will appear as follows:

3 4 5

SRR

1 —m STOP 1-A81
COUNTER -6
= [G@:00:00:00
8 =DISK 1 184min/<9

13 = <2S5CEHE 2>
MEHU DISP SHFT

(O |

10 11 12

1. Play/Record Status Symbol

This symbol displays a graphical representation
of the current FS-3 playback, stop, record or
pause state.

2. Record/Play Status Indicator

In this space, FS-3 will display a character that
notifies the user what record or playback mode
they are in. The characters displayed and their
respective modes are listed on page 41 of this
User Guide.

3. Current System Status

The current status of FS-3 will be displayed in
this area. For instance, it will display whether
FS-3 is in record, play, stop, pause, fast search
or slow motion modes.
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4.\Jolume Number

The volume or disk number of the current clip
recording or playback session is displayed in this
area of the LCD. For example, a display value of
“2-014” identifies a track as being on volume 2.

5. Track or Clip Number

This area displays the current clip or track number
being recorded or played back. For example, a
display value of “2-014” identifies a track as
being clip 14 on volume 2. If a track number has
an “*” immediately following it, that particular
track has been marker as a “Keeper” track. See
page 15 of this User Guide for more information.

6. Timecode/User Bit Display Mode

This identifies the display mode for timecode
or user bit values. Selections are:

* COUNTER - counts frames during record
or playback of the current clip only.

* REMAINING - counts down the number

of frames available (time) on a particular disk
during a record session. In a playback session,
this display shows the remaining time on the
current clip.

* DV NTSC (or PAL) - Displays the external
timecode value being generated by a
camcorder or other device during a record
session. Timecode mode has to be set to EXT
TC for this function to operate (see page 26
of this User Guide). In playback mode, this
displays the embedded DV timecode value in
a particular track.

* UB NTSC (or PAL) - Displays the set user
bit value in a particular clip. A user bit value
must be added for this to display (see page 27
of this User Guide).

* ABSOLUTE - Displays an absolute timecode
value for the particular session (sum of all

COUNTER timecode on connected volumes).
This is mainly used when FS-3 is set to AV/C
mode and is being controlled by an external
FireWire device such as a computer.

7. Timecode or User Bit Value

Displays the timecode or user bit value of
display mode selected.

8. Current Disk Volume

Displays the current disk volume in relation to
available space.

9. Available Space on Volume

Displays the space in time available on the
current volume.

10. Soft Key One Function Display

Displays the current function related to Soft
Key one (left key on the top row of buttons).
This is typically the main soft key for opening
the FS-3 MENU and is also used as a STOP
key during record and playback sessions.

11. Soft Key Two Function Display

Displays current function of Soft Key two
(middle key on the top row of buttons).

12. Soft Key Three Function Display

Displays current function of Soft Key three
(right key on the top row of buttons).

13. Folder Display

Displays folder that current clip is in. If blank,
clip is not in a folder. If folder appears in
brackets (e.g. <2SCENE 2> ), the FS-3 PLAY
FROM menu is set to FOLDER LIST. See
page 21 of this User's Guide for more details.
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FRONT PANEL BUTTONS

The FS-3 front panel features nine buttons. The
three buttons on the top row are “Soft Keys”
which allow different functions to be controlled
depending on the mode FS-3 is in. Use the
bottom line of the LCD display to identify the
current soft key function. The remaining six
buttons have a fixed function. Several of them
also feature a secondary function that can be
accessed by pressing the SHIFT key (usually
the right Soft Key).

I_ KFFEFEn _I

» >

] (2]

FS-3 buttons have the following functions:

Soft Key 1 and STOP Key n

Stops whatever is the selected mode and returns
FS-3 into Pause. A second press puts FS-3 into
STOP (standby with splash screen). Splash
screen is either a gray screen or first frame of
the selected clip depending on the PREVIEW
mode (see page 28 for more info.)

Soft Key 2 -

Dedicated soft key for triggering mode/function
that appears immediately above key in the FS-3
LCD display.

Soft Key 3 and SHIFT Key

Dedicated soft key for triggering mode/function
that appears immediately above key in the FS-3
LCD display. This key is also commonly used to
enter the SHIFT mode. To execute a shift function,
press SHIFT and another key at the same time.
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Keeper Clip and Scene Marking Keys

FireStore FS-3 features the ability to quickly
mark clips during record and playback to a
single “Keeper” folder or multiple, prenamed
“Scene Marking” folders. It is possible to use
the front keypad for Scene Marking or Keeper
Marking but it is necessary to first select either
Keeper or Scene Marking under FOLDER
PREFENCES in the SETUP menu as it is not
possible to use both at once. See page 29 of this
User Guide for more information.

If you have selected the KEEP preference, it is
possible to mark the current clip by pressing
and holding Soft Key (3) followed by Soft Key
(2). KEEPER can be marked on the current clip
during recording, playback or in stop mode.
The KEEPER label and a relational line
between the two keys is silk-screened on the
FS-3 front panel. It is also possible to mark a
clip as a KEEPER using the KEEPER button
on one of the optional remote control units.
Once a clip has been marked as a KEEPER, an
asterix (*) will appear next to the track number
("X-XXX*) on the LCD. To add all clips
marked as a KEEPER to the Keeper Folder on
the disk drive, select UTILITIES ->
ORGANIZE FOLD from the FS-3 menu.

If you have selected the SCENE MARK
preference, pressing and holding Soft Key (3)
followed by Soft Key (2) allows you to mark
each clip into particular pre-named folders on
disk (up to 10 folders can be prenamed. Default
names for the folders are 0 through 9. See page
33 of this User Guide to setup Scene Marking
folders). By holding Soft Key (3) down and
repeatadly pressing Soft Key (2), it is possible
to scroll though the available folders. It is also
possible to SCENE MARK clips to folders
using the numeric keypad on the optional
remote control units. SCENE MARK can be
marked on the current clip during recording,
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playback or in stop mode and once selected, the
clip will be marked for placement into that
particular folder. To add all SCENE MARKED
clips to their respective folders on the disk
drive, select UTILITIES -> ORGANIZE FOLD
from the FS-3 menu .

For more on KEEPER and SCENE MARKING,
see page 30 and 33 of this User Guide.

Backward Search Key n
ETETH

Pressing the backward search button multiple
times will result in increases in the search speed
during playback. This mode is bidirex in
forward X times normal search speed. A press
of the Back Search button will result in FF
speed being slowed down by one step. For
instance, if user is in 10X FF speed and presses
the Back Search button once, they will now be
in 2X FF mode. This applies vice versa for
backward search speeds. Speed resolution is as
follows: (NTSC, PAL will have slightly
different multiples for < 1X):

REVERSE : -30X, -10X, -2X, -1X (reverse
play), -1/2X(-15fps), Still.

FORWARD: Still, +1/2X (+15fps), +1X (play),
+2X, +10X, +30X

Forward Search Key m
T

Pressing the forward search key multiple times
will result in increases in the search speed
during playback. This key has the same
characteristics and bidirex function as the
backward search key listed above.

Standard forward search and reverse search also
have a “higher resolution” mode where

more speeds are available. By pressing and
holding the SHIFT key plus the forward or
backward search key, the user has access to a

larger number of playback speed choices. This
mode is the same as Standard Forward Search
in that it is also bidirex.

REVERSE: -30X, -25X, -18X, -15X, -12X, -
10X, -8X, -5X, -4X, -3X, -2X, -1X, -15fps, -
10fps, -6fps, -5fps, -3fps, -2fps, -1fps, Still

FORWARD: Still, +1fps, +2fps, +3fps, +5fps,
+6fps, +10fps, +15fps, +1X, +2X, +3X, +4X,
+5X, +8X, +10X, +12X, +15X, +18X, +25X,
+30X.

NOTE: When using the optional FS-3 remote
control units, holding down the particular button
will not repeat the function as it does on the FS-
3 control panel. For repeat sequences, the button
must be pressed multiple times.

Play Ke “
y Key

Starts playback of the selected clip. By pressing
and holding the SHIFT key plus the play
button, FS-3 will immediately go into reverse

play mode.
En

Returns to the beginning of the current clip if in
playback mode. Two presses in sequence will
return to the previous clip during playback. In
Stop mode a press will return to the beginning of
the previous clip.

Forward Index Key m

Skips forward to the next sequential clip for
playback.

Backward Index Key

The forward index and backward index buttons
also have a SHIFT mode where users can move
one frame forward or one frame backward.

PAGE 16
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When FS-3 is in PLAY or PAUSE mode and
the user presses and holds the SHIFT key plus
the forward or backward index keys, it is
possible to forward one frame or backward one
frame with each press. If in PLAY mode, FS-3
will immediately go into PAUSE mode on the
particular frame.

Record Key n

Pressing this button once puts FS-3 into
REC-PAUSE mode. A second press starts a

recording session. If this button is pressed while a

recording is in progress, FS-3 will create a new
clip on disk without dropping any frames.

REAR CONNECTOR PANEL

The rear connector panel features a 6-pin FireWire
port for DV video 1/0 (A), a 6-pin FireWire port
for connection of external FireWire drives or a
computer (B), a 4-pin XLR DC power input (C)
and a 3.5 mm control cable input for RS232C,
wired remote control or GPI. (D).
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FS-3 MENUS AND FUNCTIONS

FireStore FS-3 features a comprehensive menu
system which allows a number of features to be
initiated and setup. To enter the FS-3 MAIN
MENU, press SOFT KEY (1) while in STOP
mode. Available items in the MAIN Menu are:

REC MODE
PLAY MODE
PLAY FROM
CONTROL MODE
HDD BYPASS
REC FORMAT
SETUP
UTILITIES

The following MENU SCREEN will appear:

AR llRIEC] IMOIDE] [ [ [ ]
PLAY NODE > -2
PLAY FROM .

CONTROL HODE »

ERIT SEL \d
bt
3 4 5

1. Current Menu Item
Indicates the currently highlighted menu item.

2. Sub-Menu Available

Indicates a menu item that has a sub-menu
available. By pressing the SEL Soft Key, it is
possible to enter the sub-menu.

3. Exit
Pressing EXIT will exit the FS-3 MAIN
MENU screen.
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4, Select

Pressing SEL will select the current menu item.
If a sub-menu is available, that will open. If a
sub-menu is not available, this command simply
enables or selects the menu item.

5. Scroll Arrow
This command allows for scrolling through
menu items.

RECORD MODE MENU

HIORMAL. [REC

i
RETRO DISEK 2
RETRO CHCHE »
LOOF RECORD

EXIT  SEL l

The FS-3 RECORD MODE MENU allows
different record functions to be enabled. User
simply selects the mode. Pressing SEL will
open the sub menu. Pressing EXIT will exit
back to the menu screen. Once a particular
mode is selected in the Record Mode menu, the
unit will remain in that mode until a different
mode is selected.

Available items in the RECORD MENU are:
NORMAL REC

RETRO DISK

RETRO CACHE

LOOP RECORD

SNAP

TIME LAPSE

NOTE: When an inserted or attached HDD

is nearly full, in some record sessions, the HDD
time remaining may display “001min”
remaining. If RECORD is triggered, FS-3

will sometimes display NO SPACE LEFT.

It is advised that when a disk drive is close

to being full, other disk drives are readily
available in order to avoid lost footage.

Normal Record

Standard and default record mode. When REC
is triggered, FS-3 begins standard recording. A
single press of a STOP trigger will put FS-3
into REC PAUSE mode. A second press puts
FS-3 into STOP mode.

Retro Disk Record Mode

RETRO DISK
HOO AUAIL:
H@EE min
HETHO TIHE:
B28 min

ERIT  a v

RETRO DISK Record Constantly buffers video
in a loop to a determined amount of space on
the HDD so that when record is triggered, a
retro time period can be added

to the beginning of any clip.

RETRO DISK has the following characteristic.
Pressing a REC TRIGGER when in RETRO
DISK mode puts FS-3 into a RETRO DISK
state (FS-3’ tally light will flash as if in
PAUSE state). FS-3 is actually recording in this
state, but until the RECORD TRIGGER

is pressed a second time, the video recorded
will record over itself in a continuous loop.
RETRO DISK always keeps at least the amount
of time that is selected by the end

user in a series of one minute clips. For
instance, if the user sets the RETRO DISK
value to 3 minutes, they will always have 3
minutes (made up of three, one (1) minute
clips) of video saved to disk. As the recording
goes past the 3 minute point, a fourth clip is
created. Once that clip reaches one minute,
the oldest of the previous 3 clips is deleted.
Another fourth clip is then created.

If a user selects a RETRO session that is 60
minutes or greater, instead of one minute clips,

PAGE 18
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FS-3 creates 9 minute, 13 second clips (2GB
clips on disk). The characteristics of RETRO
DISK remains the same. The larger file size
prevents FS-3 reaching its 999 track limitation
for very long RETRO records. Due to the larger
files sizes, the maximum amount of drive space
available is decreased in order to accommodate
the last recording in a session. For instance, if a
user has 90 minutes of disk space remaining,
after the user sets RETRO record to greater than
60 minutes, the available space changes to 88
minutes of available disk space. If the user sets
RETRO time to 88 minutes, the recording will
be made up of about nine and a half 9 minute,
13 second clips. There must be space available
in this situation in order to record the final clip
which eventually will right over clip 1. This
ensures that at any given time, at least 88
minutes of video exists after a compete RETRO
DISK record loop.

NOTE: FS-3 must always have at least one
minute of disk space (under 60 minutes) or

9 minutes, 13 seconds of disk space (when
RETRO DISK value is set to greater than 60
minutes) remaining in addition to the RETRO
DISK value that has been set, in order to
function correctly. For instance, it is not
possible to set a RETRO DISK value

of one minute if only one minute of disk
space remains.

Once RETRO DISK time is set, the user can
exit the Menus and return to the Main Screen.
An “L” will now appear next to the record
symbol on FS-3’s display. Pressing the REC
trigger once will put FS-3 immediately into
RETRO DISK RECORD. Clips are being
recorded to disk for X number of minutes in
one minute increments (each as a separate
track). The tally light will flash (as if the unit is
in pause). When the REC trigger is pressed, FS-
3 will kick out of RETRO DISK mode and go
into standard record. All one minute tracks in
the set loop sequence will appear and be saved
as their own tracks on disk (e.g. 1-001, 1-002,
1-003 etc.) except for the recording that was in
progress, which takes on the characteristics of a
standard track. At this stage, FS-3 is essentially
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in standard record mode (the “L” on the display
will disappear). No frames will be lost across
tracks during the record session. Once paused,
the unit will return to RETRO DISK record
mode again (the “L” will reappear in the LCD
and viewfinder) for further RETRO recordings
or until it is disabled n the RETRO DISK
Menu.

RETRO DISK can be used in LOCAL and
SYNCRO SLAVE RECORD control modes.

WARNING: Make sure FS-3 is in STOP mode

before removing the disk drive from the system.
Do not attempt to remove when FS-3 is in REC
or REC-PAUSE mode.

Retro Cache Record Mode

HETHO CHCHE
CACHE : 1HB=ec

ExlT | & v

RETRO CACHE Record constantly buffers
video in a loop to a 10 second data buffer to
cache video so that when record is triggered,

a retro time period can be added to the beginning
of any clip.

NOTE: Retro cache mode utilizes the same
memory data buffer as used for shock
protection on FS-3. If Retro Cache mode is not
being used, all the FS-3 cache is available for
shock protection. If Retro cache is ON, the
shock buffer time will be reduced by the
amount of cache time that is selected and
therefore performance may vary.

RETRO CACHE has the following
characteristic. Pressing a REC TRIGGER when
in RETRO CACHE mode puts FS-3 into a
RETRO CACHE state (the TALLY light on FS-
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3 will flash as if in PAUSE state). FS-3 is
actually recording in this state, but until the
RECORD TRIGGER is pressed a second time,
the video recorded will record over itself in a
continuous loop. It is much the same as
RETRO DISK recording in theory except that it
utilizes a data buffer that is separate to the

disk drive to cache video. RETRO CACHE is
also accurate down to the frame instead of the 1
minute clips used in RETRO DISK. Once a
RETRO CACHE value is set, pressing the REC
trigger once will put FS-3 immediately into
RETRO CACHE Record. A “C” will now
appear next to the record symbol on FS-3’s
display. Video is being recorded to the FS-3
cache. The tally light will flash (as if the unit is
in pause). When the REC trigger is pressed, FS-
3 will kick out of RETRO CACHE record
mode and go into standard record (the “C” on
the display will disappear). Any clip that is
recorded in this mode will have the contents of
the cache added to the beginning of the clip.
Once paused, the unit will return to RETRO
CACHE record mode again (the “C” will
reappear in the LCD and viewfinder) for further
RETRO CACHE recordings or until it is
disabled in the RETRO CACHE REC Menu.

RETRO CACHE RECORD can be used in
LOCAL and SYNCRO SLAVE RECORD
control modes.

WARNING: Make sure FS-3 is in STOP mode

before removing the disk drive from the system.
Do not attempt to remove when FS-3 is in REC
or REC-PAUSE mode.

Loop Record

The LOOP Record feature allows video to be
recorded to available disk space on the
connected disk drive(s) in an endless loop. To
use LOOP RECORD, simply select in the FS-3
RECORD MENU. Once highlighted, an “O”
will appear on the top line of the FS-3 LCD
next to the PLAY/RECORD STATUS
SYMBOL. When record is triggered, FS-3 will
begin recording on available disk drive space.

Like the RETRO DISK feature, when FS-3 is in
LOOP RECORD mode, it records sequential
one minute clips to the disk drive. When only
one minute remains on the disk drive, FS-3
loops back to record over the oldest one minute
clip and so on. It is possible to PAUSE FS-3 in
this mode and then continue a LOOP RECORD
by starting record once again. FS-3 will remain
in LOOP RECORD mode until a recording is
stopped. Once stopped, the files on disk will
not be erased if a new LOOP RECORD session
is begun.

If the available time on disk is 60 minutes or
greater, FS-3 will record sequential 9 minute,
13 second long clips instead of one minute
clips. The larger file size prevents FS-3 from
reaching its 999 track limitation for very long
LOOP RECORDS.

Snap

When SNAP is selected and REC is triggered, a
single frame is grabbed. SNAP can only be
used in LOCAL control mode.

If SNAP is the RECORD MODE when power
is cut to the unit or it is turned off, on re-boot,
FS-3 will be in NORMAL REC mode.

Time Lapse

TINE LAPSE
EE:66:81:80

| 44 B ee|
AOVES CURSOR

EAIT

e w

It is possible to select a time lapse interval of up
to twenty-four hours. Interval is the period of
time between FS-3’s capture of a single frame
of video (a value of 00:00:01:00 means one
frame will be recorded every second). REC
INTERVAL is set by the user pressing the up and
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down buttons. Time is selectable in seconds (up
to 59), then minutes up to 59. Buttons can be
released at any time to slow advance. EXIT will
exit back to the menu screen.

PLAY MODE MENU

FLAY CLIP
LOOF ULIF
LOOP ALL
FLAY HLL

EAIT v

The FS-3 PLAY MODE MENU allows
different playback functions to be enabled. User
simply selects the mode. Pressing EXIT will
exit back to the menu screen. Once a particular
mode is selected in the Play Mode menu, the
unit will remain in that mode until a different
mode is selected.

Available items in the PLAY MODE MENU
are:

PLAY CLIP

LOOP CLIP

LOOP ALL

PLAY ALL

Play Clip

In this mode, FS-3 will play the selected clip
from start to finish when the PLAY button is
pressed. At the end of the particular clip, FS-3
will pause.

Loop Clip

In this mode, FS-3 will play the selected clip
from start to finish. Immediately after
completing the clip, FS-3 will begin playing the
clip again without a pause. It will stay in this
state until stopped.
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Loop All

In this mode, FS-3 will play the entire contents
of the disk (all clips from the selected

clips) in order from start to finish. At the end of
the last clip, FS-3 will begin to play from the
beginning of the first clip again without a pause.
It will stay in this state until stopped.

Play All

In this mode, FS-3 will play the entire contents of
the disk (all clips) in order from start to finish. At
the end of the last clip, FS-3 will pause.

NOTE: Play Mode operation varies depending
on whether Track List or Folder List is selected
in the PLAY FROM menu. When Track List is
selected, clips are played back based on the
entire disk drive. When Folder List is selected,
clips are only played from the selected folder.”

PLAY FROM MENU

TRACK LITIST L]
FOLDER LIST »

EXLT & L

The FS-3 PLAY FROM MENU allows the user
to select where clips will be played back from.
There are two options available:

Track List

When this setting is selected, all clips on attached
disk drives will be played back sequentially based
on the order of their base file name regardless of
whether they have been marked in the KEEPER
or SCENE MARKING folders. If Track List is
selected, all PLAY MODES relate to all clips on
the connected disk drives.
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Folder List

When this setting is selected, it is possible to
play back clips only from a selected folder.
Select a particular folder to play clips from.
Highlighted folder is the selected folder after
exit. Once set and when PLAY is pressed, only
clips within that particular folder will playback.
If Folder List is selected, all PLAY MODES
relate to clips in the selected folder only.

If the FS-3 PLAY MENU is set to
“TRACKLIST” the name of the SCENE
MARKED folder will appear without brackets
on the LCD display (e.g. 2 SCENE 2). If the
PLAY FROM menu is set to “FOLDERS”, the
name of the SCENE MARKED folder will
appear in brackets on the LCD display (e.g. 2
<SCENE 2>).

CONTROL MODE MENU

AU/C
SYHCRD 5LAVE

EXIT SEL -

The FS-3 CONTROL MODE MENU allows
different control options to be enabled. User
simply selects the mode. Pressing EXIT will
exit back to the menu screen. Once a particular
mode is selected in the Control Mode menu, the
unit will remain in that mode until a different
mode is selected.

Available items in the CONTROL MODE
MENU are:

LOCAL
AV/C
SYNCRO SLAVE

Local

In this mode, FS-3 is controlled via the front
panel buttons only. The camcorder tape
transport and FS-3 have independent control.

AV/C

utilized in PLAYBACK and RECORD
situations where FS-3 is controlled by an
external FireWire device (such as a DV NLE
system), connected to the “DV 1/O port” on FS-
3. For example, you may like to record the
ouput of your NLE's timeline to FS-3.

NOTE: AV/C is NOT for use in FS-3
RECORD MODES.

Syncro Slaved

In SYNCRO SLAVED mode, the camcorder and
FS-3 share the same REC trigger and FS-3 is
slaved to the camcorder. Once set and the user
exits the CONTROL MENU, they will return to
the default splash screen. FS-3 also immediately
enters REC PAUSE mode and a “Y” appears
next to the record symbol on the LCD. All
triggers of REC and REC PAUSE are controlled
by the camcorder exclusively. Every time the
camcorder REC button is pressed, FS-3 goes into
the particular RECORD MODE that is selected.
When pressed a second time, FS-3 goes into
REC PAUSE. Another press of the REC button
on the camcorder again starts the particular
RECORD MODE that is selected. At this point,
a new track is created on disk. Timecode
generated by the camcorder is recorded to the
file when FS-3 is set to EXT TC mode.

When used with RETRO DISK or RETRO
CACHE modes, as soon as SYNCRO SLAVE
is set, the camcorder begins recording to disk.
A press of the REC trigger on the camcorder
kicks FS-3 out of RETRO DISK or RETRO
CACHE and goes into standard REC. When the
camcorder is triggered back into REC PAUSE
mode, FS-3 once again goes into RETRO DISK
or RECORD CACHE mode again.
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The FS-3 buttons (other than MENU, DISP and
SHFT) are locked out when in this mode, as is
wired or infrared remote control units. If in
VTR mode on the camcorder, all keys work. The
user is only able to exit SYNCRO SLAVE by
entering the CONTROL MENU which they can
do directly by pressing the MENU button when
on the FS-3 default splash screen. If the
camcorder is set to VTR mode, FS-3’s control
panel becomes active in order to allow playback.

HDD BYPASS

HDD Bypass mode allows the connected
FireWire HDD to be mounted/dismounted to

a computer without removing. In this mode, the
computer connects to the HDD 1/O port

on the FS-3 Rear Connector Panel.

WARNING: Do not connect FS-3 to a
computer until the HDD port in the set up
menu has been set to Bypass.

When HDD Bypass is selected, the following
will display on the FS-3 LCD:

GO TO HODD
BYPRSST

ERIT YES HO

If this screen does not appear, the FS-3 HDD
1/0 port is set for use with external drives.

HOD PORT
SET TO HDD
PLERSE SET
HOO PORT
TO BYPASS

ERIT
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To set the HDD Port, go to the Main Menu and
select SETUP -> HDD PORT. Once set, it will
be possible to set FS-3 to HDD Bypass mode.

Once in HDD Bypass mode, the following LCD
display will appear:

HOD BYPASS
EHABLED:

ERAIT

To Exit this mode, simply press the EXIT key.
Be sure to properly dismount the FireWire drive
from the computer system first before exiting
HDD Bypass mode on FS-3.

RECORD FORMAT MENU

HAL DU

AUI TYPE |

AUI TYPE 2

CAHOPUS RAUI

EAIT i

The RECORD FORMAT menu allows selection
of particular DTE Technology native NLE file
formats prior to recording. All files are in the
DV25 standard.

Available items in the RECORD FORMAT
MENU are:

RAW DV

AVITYPE 1

AVI TYPE 2

CANOPUS AVI

MATROX AVI

QUICKTIME

AVID OMF
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User simply selects the format. Highlighted
format is current format after exit. Pressing
EXIT will exit back to the menu screen.
Selected format will stay set until user selects a
different format (even if the power is cycled).

SETUP MENU

HIDD! PIIRT .
OATE FORNAT »
SET DATEETINE®
05 UERS. NO. »

ERXIT SEL -

The SETUP MENU allows various functions of
FS-3 to be set. User simply selects the Setup
Item. Pressing SEL will open the sub menu.
Pressing EXIT will exit back to the menu
screen. Unless mentioned, the particular setup
menu will stay set until user selects a different
setting (even if the power is cycled).

Available items in the SETUP MENU are:
HDD PORT

SET DATE&TIME
OS VERSION NO.
OS UPGRADE

TC MODE

TC SET

IR

GPI

BACK LIGHT
CLIP PREVIEW
AUDIO CORRECT
FOLDER PREF

HDD Port

ERIT v

The HDD Port setting allows the user to assign
a function to the FS-3 “HDD 1/O” port.
BYPASS mode is for making the internal disk
drive available to an external device (such as

a computer). HDD Mode is used when the
“HDD 1/0” port is used for connecting
external FireWire disk drives. Pressing

EXIT will exit back to the menu screen.

Set Date and Time

SETL OATE [ [
SET TIME 3

ERAIT SEL -

Allows for setting date and time for file naming
purposes. Date and Time are set in different
menus. Pressing the SEL button

will open the sub menus.

SYSTER DATE
a8 38/83

|44 £ ®e|
NOUES CURSOR

ERAIT & ”
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SYSTEM TINE
Bl 4629

|44 E ek
NOUES CURSORA

ERXIT & v

Scroll from value to value using the
FORWARD and BACK INDEX Buttons.
Press DOWN and UP arrow to scroll though
digits in value. Pressing EXIT will exit back
to the menu screen. User simply selects the
Menu Item. Pressing SEL will open the sub
menu. Pressing EXIT will exit back to the
menu screen.

The Date and time form the basis of the FS-3
file naming structure for use of clips on a
computer.

On FS-3, files are identified by TRACK and
VOLUME (disk drive) number on the LCD. For
instance, a file on the FS-3 LCD identified as
1-043 is clip number 43 on Volume (disk) 1.

On a computer, files are identified by their base
file name made up of DATE and TIME. For
instance, a clip named 20030615-210943-
01.mov is a clip that began recording at
9:09:43PM on June 15th. 2003.

NOTE: DATE/TIME is used when creating File
name only. FS-3 does not record this
information into the stream. FS-3 records
DATE/TIME which is in the DV stream which
is sent from the camcorder.
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Operating System Version No.

0S5 UERSION HO,
3.9, mB3061283

ERIT

Displays the current system software version.
Operating System Upgrade

To upgrade system software, the user must
download a new .bin file to a FireWire drive on
their computer. The latest version of

FS-3 software can be downloaded from
http://www.focusinfo.com/support .

To install new OS software to FS-3,

do the following:

1) Download software from the Focus Website
to your local computer.

2) Unzip file using WinZip (Windows) or
Stuffit (Macintosh) on a computer system with
a FireWire (IEEE-1394) connection.

3) Rename the unzipped file called
“XXXX.bin” to “fs3.hin”.

4) Connect a FireWire disk drive that has been
used with FS-3 to the computer and copy over
the file “fs3.bin”.

5) Disconnect FireWire drive from computer
and connect to FS-3. Power on FS-3 as per
normal.

6) Enter the FS-3 menu and select “SETUP”.
From the SETUP menu, select “OS
UPGRADE".
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IFGRADE Timecode Mode
SYSTEN _ _
SOF TURRE?
REC RUH
REGEHN
FREE RUH
EAIT YES HO
UPDATIHG EXIT v
g E ﬁ ;EE RE Allows user to select different timecode options

7) When prompted “DO YOU WANT TO
UPGRADE SYSTEM SOFTWARE?” answer
YES and YES to the warning messages.
WARNING: Upgrade will erase current OS!!

8) After upgrade is complete, power cycle
FS-3. The new software should now
be loaded and ready to use.

05 UPGRADE
CONPLETE.

FLERSE
RESTRRT
SYSTEN,

If no .bin file is found, the screen

will display “OS UPGRADE ERROR”. It is
necessary to restart your system once an OS
upgrade is complete.

NOTE: If you need to restore the factory default
Operating System, hold down the Forward and
Backward Index keys during boot up.

for use when FS-3 is recording. User simply
selects the mode. Highlighted mode is current
mode after exit. Pressing EXIT will exit back to
the menu screen.

EXT TC Mode - Whatever the incoming

DV timecode, FS-3 records it. If the Camcorder
TC is not running, and FS-3 is recording, the

same TC number will be in each frame of DV.

Choosing EXT TC mode will clear any stored
number.

NOTE: If FS-3 is set to EXT TC when in
SYNCRO SLAVE mode, EXT TC will stop
once tape in camcorder ends. Use different

TC mode when using SYNCRO SLAVE.

(TC Preset cannot be changed while in the EXT
TC mode.)

REC RUN Mode - In this mode, FS-3 does the
following:

(1) the last timecode number recorded + 1 will
be used as the timecode number for the first
frame of the next recording.

(2) the number entered by a setting in the TC
PRESET menu will be used for the first frame
of the next recording.

The last number used is stored in the memory,
so this mode persists across recording sessions.
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REGEN Mode - After a disk is mounted

(at startup, upon manual connect) and

after the track list has been constructed,

FS-3 looks at the last track and looks at the
timecode number of the last frame in that track.
FS-3 stores that number for use as the TC value
(+ 1) for the first frame of the next recording.

If the drive is empty, FS-3 uses the value (+ 1)
stored in memory.

FREE RUN Mode - When the user

enables FREE RUN mode, FS-3 begins
counting from the value stored. If the user uses
the TC PRESET function, when the number is
entered and the TC PRESET menu is exited,
FS-3 begins counting.

NOTE: When the FS-3 timecode

mode is set to EXT TC and the camcorder time
code mode is set to PRST/REC or REGEN, it is
not possible to record timecode continuously
when recording to disk only. Set the FS-3
timecode mode to REGEN, REC RUN or
FREE RUN (not EXT TC) when recording to
disk only.

Timecode, UserBit and Drop/Non-Drop
Preset

T PREISET
UE PRESET | »
DROF/HON-DROP»

ERIT | SEL

This menu allows the user to set timecode

and user bit values for various modes. It

also allows selection of drop or non-drop frame
(NTSC only) settings. User simply selects the
Menu Item. Pressing SEL will open the sub
menu. Pressing EXIT will exit back to the
menu screen.
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TC PRESET
BB:47:89:24

| A4 E ek
NOUES CURSOR

EAIT & ul

Once a timecode value is set and FS-3 is set to
REC RUN or FREE RUN timecode settings, the
preset value will be the starting point for
timecode. Use the forward and back index buttons
to move from value selection to value selection.
Press the up and down arrows to set values.

UB PRESET
@3 63 ac 3E

|44 & |
NOUES CURSOR

ERIT & v

Allows the user to set a user bit value. Use the
forward and back index buttons to move from
value selection to value selection. Press the up
and down arrows to set values.

HUH-DROP

EAIT ul

For DROP and NON-DROP, user simply selects
the mode. Highlighted mode is current mode
after exit. Pressing EXIT will exit back to the
menu screen. This item not applicable for PAL
use. On the FS-3 display, DROP will be
identified by a (:) symbol and NON-DROP by a
(;) symbol.
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Infrared Sensor Settings

EMAELE
OISABLE

ERIT u

This menu allows the user to ENABLE or DISABLE
the IR sensor on FS-3. User simply selects the Menu
Item. Highlighted mode is current mode after exit.
Pressing EXIT will exit back to the menu screen.

GPI Settings

DI SHELIE
PAUSE /UNPAUSE
[HOEX/HEW FILE
REC SHAPSHOT

ERIT v

This menu allows the user to change the setting of
the GPI port. User simply selects the Mode.
Highlighted mode is current mode after exit.
Pressing EXIT will exit back to the menu screen.

DISABLE allows user to connect the supplied
3.5mm to DB9 cable to the GPI port and control
FS-3 via RS232C from an external device.

The remaining three items allow functions to
occur from a simple contact closure. Modes are
PAUSE/UNPAUSE (allows control of pause and
unpause during a record or playback session),
INDEX (NEW FILE) (allows a new file to be
created during a record session without losing any
frames) and REC SNAPSHOT (allows a single
frame of video to be recorded to a file. Each
sequential trigger in this mode will add another
frame to the same file until stopped).

LCD Backlight Settings

UFF
AUTO OFF

ERIT ul

This menu allows the user to enable or disable
the FS-3 LCD back-light. Highlighted state is
current after exit. Pressing EXIT will exit back
to the menu screen.

The ON setting will keep the back-light on
permanently while the OFF setting will keep
the back-light off permanently. AUTO OFF
will turn off the back light after one minute.
Pressing any keypad button on FS-3 will turn
the back-light back on in AUTO OFF state.
This setting is advisable in high temperature
environments and also to reduce power
consumption.

Clip Preview Settings

CLIF PREVIEM

oH L]
OFF

ERIT i

This menu allows the user to select CLIP
PREVIEW ON or OFF. When CLIP PREVIEW
is ON, the camcorder is in VTR mode and the
user scrolls from one clip to the next on FS-3
using the buttons, the first frame of each clip
will be generated and showed via DV output
after one second if the user pauses on

that clip.
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User simply selects the Mode. Highlighted
mode is current mode after exit. Pressing EXIT
will exit back to the menu screen.

Audio Correction Settings

FF
neoIun
HIGH

ERIT d

This menu allows the user to change the
AUDIO CORRECTION setting on FS-3. User
simply selects the Mode. Pressing EXIT will
exit back to the menu screen.

AUDIO CORRECTION modes is an advanced
feature of FS-3. It is recommended that the
customer uses the factory default settings for
most operations (Factory default

is MEDIUM). Audio Correction Mode allows
the user to alter the performance of the audio
error corrector while recording. It is useful
when recording to FS-3 from tapes with lots of
dropouts. Error correction will only effect AVI
2, Canopus AVI, Matrox AVI, QuickTime and
AVID OMF. It does not effect RawDV

or AVI 1. The modes are:

OFF - No audio correction.

MEDIUM (default) - For “normal” clean
tape played back on camcorder or other VTR
with clean heads. Experiences occasional very
short audio mutes.

HIGH - For cases where there are visible
picture disturbances and likely long audio
dropouts (1/2 sec and up).
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Folder Pref

The FS-3 KEEPER PREFERENCE folder
allows use of a single KEEPER folder or
multiple SCENE MARKING folders. The
highlighted preference is selected on EXIT.
See SCENE MARKING section on page 33 of
this User Guide for more details.

SICEHEL MARKL |||
KEEP

EALT i

UTILITIES MENU

DRGANTIAE] KE
OAGAHIZE 0N
DELETE CLIP
FORNAT

T [anl
v v ¥ id

EAIT SEL =

The UTILITIES MENU allows various utility
functions of FS-3 to be set. User simply selects
the Utilities Item. Pressing SEL will open the
sub menu. Pressing EXIT will exit back to the
menu screen.

Available items in the UTILITIES MENU are:

ORGANIZE FOLD
ORGANIZE OMF
DELETE CLIP
FORMAT
PARTITION
REPAIR

FILE NAME
FACTORY RESET
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Organize Folders

ORGANI ZE
KEEP CLIPS?

ERIT YES HO

Places all files that were identified as a
KEEPER or were SCENE MARKED during
recording into a folder marked KEEPER or the
prenamed SCENE MARKING folders on the
disk drive. These folders can be imported
directly into most DV NLE bins.

Organize OMF

ORGAMIZE AUID
ONF CLIPS?

ERIT YES HD

When files are recorded in the AVID OMF file
format, this command automatically takes all the
OMF and AIF audio files at the end of a
recording session and places them into a folder on
the disk drive named “OMFI MediaFiles”. When
the disk is connected to a computer, this folder is
recognized by Avid’s Media Tool feature enabling
direct import of files into the Avid timeline.

NOTE: If you have selected files as a KEEPER or
they have been SCENE MARKED, it is not
possible to use this feature and keep files in their
selected folders. If you would like to use clips in
KEEPER or SCENE MARKED folders in Avid,
manually create the “OMFI MediaFiles” folder
when your disk drive is on your computer and
drag desired clips into this folder.

Delete Clip
DELETE
CLIP 1-8817
BASE :
2BBA3AG15~-
211938
EXIT YES

With this function, it is possible to delete the
selected clip. In the DELETE CLIP X-XXX
screen, user can select between clips by pressing
the forward and back index buttons. Pressing
YES will begin the delete process. Pressing
EXIT will exit back to the menu screen.

NOTE: FOCUS recommends not deleting clips
frequently. It may cause fragmentation.

DELETIHG
CLIP 1-881
BASE :
2HA3B615-
211938

&k kR

EAIT YES

Once a clip has been deleted, the FS-3 display
re-organizes the clip number sequence. For
instance, if there are three clips on disk (1-001,
1-002, 1-003) and the user deletes clip

1-002, after delete is complete, clip 1-003 will
become clip 1-002. Base file names are not
affected however.

Format Disk

With this function, it is possible for the user

to format a disk. It is recommended that this

is done after each record session to prevent
fragmentation and other problems with the disk
drive.
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WARNING: FORMAT ERASES ALL DATA
ON THE DISK DRIVE!

FORMAT DISK
UOLUNE 17

EAIT YES HO

To exit from format, press either NO or EXIT.
To continue with format, press the YES key.

FORMAT MWILL
ERASE ALL DATH
COHTIHUE
FORMAT woOL 17

ERIT YES HO

To exit from the warning screen, press either NO
or EXIT. To begin the format, press the YES key.

FORMATTIHG
UOLURME 1

& % ok ko ok

FireStore FS-3 utilizes a FAT32 format type. If
you are using a non-FAT32 formatted drive, see

the section on Partitioning a volume. Once
complete, the disk drive is ready for use with
FS-3. It is advised that the drive be formatted
before a new record session is begun.
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After a format is complete, ten file folders are
added to the disk drive (numbered 0-9). These
folders are utilized in the SCENE MARKING
feature (see page 33 of this User's Guide for
details). Also added to the disk is a LOG folder,
a DESKTORP folder and two additional files
called Desktop DB and Desktop DF. Do not
delete these files as they are required for
FireStore operation.

Partition Volume

When an unknown or blank volume type
(HDD) is connected to FS-3, the Partition
process puts a FAT32 format onto the drive. It
will erase any previous partition and data.

PARTITION HUILL
ERASE ALL DATH
CONTIHUE

PARTITION UOL?

ERIT  YES HO

To exit from partition, press either NO or EXIT.
To continue with partition, press the YES key.

WARNING: PARTITION ERASES ALL DATA
ON THE DISK DRIVE!

PARTITION IHG
UOLUNE

EEE RS S R

Once complete, the disk drive is ready for use
with FS-3.



FOCUS

enhancements

FireStore FS-3 User Guide
Repair Disk ERROR
o FOUHD 0N
CHECE! IDISE UOLUME 1
CURREHT CLIP » REPRIRY
EXIT YES HOD

ERIT | 3EL | | ™

REPAIR allows the user to select either
CHECK DISK or CURRENT CLIPR.

CHECE DISEK
UOLUME 17

ERIT SEL »

CHECK DISK scans the entire volume for any
errors (usually, if a disk was corrupted during a
recording due to sudden power loss, check disk
will alert the user of this). To exit check disk,
press either NO or EXIT.

CHECKIHG DISK
UOLURME 1

% o ok o ok ok E

If an error is found, the user will be prompted
to repair the file. File repair only takes a few
moments to complete in most cases.

CURRENT CLIP does a similar function, but
on the selected clip only. If an error is found,
FS-3 will prompt the user to repair the problem.

File Name

CLIP 1-881
BASE :
28838615-
H32649

EAIT

File Name displays the base file name of the
selected clip.

Factory Reset

FACTORY RESET

CONT IHUE
TO RESET
SYSTEN?

EAIT YES HO

When this function is selected, FS-3 will revert
all settings and values back to their factory
default state. Pressing YES will start

factory reset. Pressing EXIT or NO will exit
from menu. Warning: Factory Reset is

not un-doable!!!
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The following screen will display when complete:

FACTORY RESET
CONFLETE

ERIT

After factory reset is complete, please restart
Fs-3

Factory Default States Are as Follows:
Display:
* COUNTER

Rec Mode:

* DEFAULT REC MODE: NORMAL

* RETRO DISK — RETRO VALUE -> 000min
* RETRO CACHE - CACHE ->00 sec

* TIME LAPSE —> 00:00:00:00

Play Mode:
* DEFAULT PLAY MODE: PLAY CLIP

Play From:
* DEFAULT PLAY FROM MODE:
TRACK LIST

Control Mode:
* DEFAULT CONTROL MODE: LOCAL

Rec Format:
e DEFAULT REC FORMAT: AVI TYPE 2

Setup:

* HDD PORT -> HDD

* SET DATE&TIME :

» DATE: 07/24/03

* TIME: 12:00:00

* OS VERSION NO. -> VARIABLE
*TC MODE -> EXT TC

* TC SET:

* TC PRESET -> 00:00:00:00

« UB PRESET -> 00 00 00 00

* DROP/NON-DROP -> NON-DROP
* IR -> ENABLE
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* GPI -> DISABLE

* BACKLIGHT -> ON

e CLIP PREVIEW -> PREVIEW ON

* AUDIO CORRECTION -> MEDIUM
* FOLDER PREF -> SCENE MARK

USING SCENE MARKING

The FireStore FS-3 SCENE MARKING
feature allows clips to be marked for
placement in particular folders during
recording, playback or stop mode. When a
drive is formatted using FireStore, ten folders
will be created numbered 0 through 9. After
format on FireStore, it is possible to connect
the HDD to a computer and give each of these
folders a custom name (if you need help
mounting your FireWire HDD to your
computer system, see section titled “Getting
FireStore Recorded Clips onto a Computer”
on page 34 of this User's Guide). To rename
each folder, simply click on the folder name
until it is highlighted, then type in the desired
name of the folder.

NOTE: Folder names cannot exceed eleven
characters.

Folders will be ordered on FireStore in
numerical followed by alphabetical order. For
instance, if folders are named “Scene 17,
“Scene 2” and “Auditions”, they will appear
on FireStore as “1 Auditions”, “2 Scene 1” and
“2 Scene 2”. The folder number is added in
front of the folder name on the FS-3 LCD
display for easy identification when using the
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optional remote control commander keypads.

If you would like to create a custom order to
Folders, it is recommended that you change the
name to change the numerical/alphabetical order.

To use SCENE MARKING, it is necessary to
first enable the SCENE MARK setting under
FOLDER PREFs in the SETUP menu. Once
you have selected the SCENE MARK
preference, pressing and holding Soft Key (3)
followed by Soft Key (2) allows you to mark
each clip into the selected, prenamed folder on
disk. By holding Soft Key (3) down and
repeatedly pressing Soft Key (2), it is possible
to scroll though the available folders. Each
SCENE MARK FOLDER is shown on the FS-
3 LCD display.

B STOP 1-881
COUHTER
AB:08:A6: 88
DISK 1 184min

< 2SCEHE 2>
NHEHU DISP SHFT

If the FS-3 PLAY MENU is set to
“TRACKLIST” the name of the SCENE
MARKED folder will appear without brackets
on the LCD display (e.g. 2 SCENE 2). If the
PLAY FROM menu is set to “FOLDERS”, the
name of the SCENE MARKED folder will
appear in brackets on the LCD display (e.g. 2
<SCENE 2>.

It is also possible to SCENE MARK clips to
folders using the numeric keypad on the
optional remote control units (see page 38 of
this User Guide for more information). To
add all SCENE MARKED clips to their
respective folders on the disk drive, select
UTILITIES -> ORGANIZE FOLD from the
FS-3 menu. Once complete, an additional file
is added to the disk named “grade” and files
are moved to the selected folder for easy

access on an NLE system. Do not delete the
file named “grade” from the disk if you intend
to use the disk on FireStore again.

GETTING FIRESTORE RECORDED
CLIPS ONTO A COMPUTER
SYSTEM

Once you have recorded clips to your
FireWire disk drive using FireStore, it is
possible to use those clips in most computer
based DV NLE systems.

Traditionally, in order to get footage into

your NLE system, it was necessary to

capture or digitize that footage utilizing a
video capture card. Using FireStore FS-3
recorded clips, it is possible to skip this
capture stage by simply connecting the
FireWire disk drive to your computer via an
OHCI compliant IEEE-1394 (FireWire) PCI
card or connection. FireWire disk drives that
were used with FireStore FS-3 can

be connected to any computer system that

will read a FAT 32 volume. This includes
Windows 98SE, Windows ME, Windows 2000,
Windows XP and Mac OS9 and 0S10. FAT32
volumes will not work with Windows NT and
older Macintosh based operating systems.
Check the FOCUS Enhancements’ website
(Wwww.FOCUSinfo.com) for more information.

In order for you to use FireStore FS-3
recorded FireWire disk drives on a computer,
you must have an active IEEE-1394 connection
on your computer. You also must have loaded
any required FireWire disk drive drivers onto
your computer system (Consult your FireWire
disk drive documentation for more information).

Simply connect your FireWire disk drive to
your computer system utilizing a standard 6-
pin to 6-pin FireWire cable and connect power
to the drive if necessary (some FireWire disk
drives receive power from the computer’s
FireWire connection. Consult your FireWire
disk drive documentation for more information).
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Mounting FireWire Disk Drives to Windows
XP, 2000, 98SE and ME Computer Systems

On a Windows based computer system, simply
double click the My Computer icon on the top
left hand corner of the desktop. You will see
the following window:

Foom hwee S 0] S L

Locate your FireWire disk drive. This will
probably be labeled (E:), (F:), (G:) etc. (drive
C: is usually your computer’s main disk drive).
Once located, double click on the FireWire
disk drive. (If you have trouble locating the
FireWire disk drive, right mouse click each
drive and select Properties from the menu.
Click the Hardware tab which will list the
drive type). Once opened, you should see the
following window:
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The FireWire disk drive contains several
different files. Clips can appear as RawDV
(.dv), AVI Type 1 (YYYYMMDD-
HHMMSSa01), AVI Type 2 (YYYYMMDD-
HHMMSSh01), Canopus AVI
(YYYYMMDD-HHMMSShO01), Matrox AVI
(YYYYMMDD-HHMMSSmO1 with a
separate .wav audio file per track), QuickTime
(.mov) and Avid OMF (.omf with two separate
.aif audio files per track.).The FAT32 file
system has a limitation where any particular
file cannot exceed 2GB in size. This equates
to roughly 9 minutes of recording time.
When clips are being recorded to FireStore
that exceed 9 minutes in length, FireStore
automatically creates a new file without
dropping any frames. The two clips will

have the same primary file name, however,
the last tow digits will be different. The first
2GB part of the clip will be labeled with
“-01” after the primary file name. The second
2GB segment will be labeled with a “-02”.
Additional 2GB segments will be labeled
with a “-0X” number.

With most NLE systems on a Windows
computer, it is possible to utilize clips

within the timeline simply by selecting the
clips on the source volume (in this case, the
connected FireWire disk drive) and importing
them directly into the NLE’s bin. Clips can
then be immediately used in the NLE’s
timeline. With FireWire disk drives such as
the FireStore FSHDD-1, the drive itself is fast
enough to directly stream the clips to the NLE
eliminating the need to copy or transfer the
clips before use.

When utilizing the Avid OMF file format, it
is necessary to follow the following steps to
import clips.
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Using FireStore FS-3 recorded Avid OMF
clips on Avid NLE Systems

The Avid DV OMF file format was developed
for use with Avid Xpress DV version 3.0 or
latter on Windows 2000, Windows XP or Mac
0S10. FireStore OMF clips are also compatible
with certain NewsCutter, Xpress Pro and Media
Composer systems. Check the Focus Website
for an up to date list. The Avid DV OMF file
format creates three files simultaneously; an
OMF video file and two separate AlF audio
files. On the computer’s desktop, the files will
look like this...

On the FireStore FS-3, the video file (OMF) and
the audio files (AIF) appear as one track. If you
delete an Avid DV OMF file, FireStore will delete
the audio and video portions at the same time.

In order to use the FireStore FS-3 recorded
Avid DV OMF files on your Avid system from
the external FireWire drive, you must do the
following...

1. Locate the external FireWire drive on your
computer. (If you have trouble, you can locate
the name of the external drive by selecting My
Computer on a Windows system. On a Mac, the
FireWire drive should appear on the desktop).

2. Open the FireWire drive when you
have found it and create a new folder named
“OMFI MediaFiles”. To do this on Windows,

select File -> New -> Folder from the pull
down menu. On Mac, select File -> New
Folder. It is important that “OMFI MediaFiles”
is typed correctly in order for Avid to see the
disk drive. Drag all the OMF and AIF files into
the new folder (do not drag in the files titled
Desktop DB or Desktop DF).

NOTE: if you are using the ORGANIZE OMF
function on FS-3 prior to using the disk on a
computer, step 2 is not necessary. If you have
selected files as a KEEPER or they have been
SCENE MARKED, It is not possible to use this
feature and keep files in their selected folders.
If you would like to use clips in KEEPER or
SCENE MARKED folders in Avid, manually
create the “OMFI MediaFiles” folder when
your disk drive is on your computer and drag
desired clips into this folder.

3. Launch Avid. Once you have opened the desired
project or created a new project, select Tools ->
MediaTool. The following window will appear:

4. Locate and select the external FireWire drive
under Media Drive(s). (NOTE: If the drive does
not appear, check that you have created the
OMFI MediaFiles folder correctly with proper
case and spacing. Also, check to see that the
drive is properly connected and recognized by
the computer).
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Under Project(s), select All Projects (This will
highlight all items in the Project(s) window).
Ensure Master Clips is checked then press OK.
The following Media Tools Window will appear:

5. Create a new bin (select File -> New Bin) or
open an existing bin in Avid. Once opened,
select all items in the Media Tools window
(select Edit-> Select All). Drag the contents of
the Media Tools Window into the bin. It is now
possible to use these clips in the Avid timeline.

Dismounting FireWire Disk Drives
from Windows XP, 2000, 98SE and ME
Computer Systems

Once you have completed working with your
disk drive on a Windows XP, Windows 2000,
Windows 98SE or Windows ME computer
system, you must first dismount the drive
before unplugging it. To do this, simply click
on the Stop Device icon at the bottom right side
of the Windows task bar. See Below:

The Windows

“STOP
DEVICE”
Icon - e

o

Once clicked, your computer system will
prompt you to “STOP” the connected FireWire
disk drive. This will begin the dismount
process. Select the message by clicking on it.
The computer will now dismount the disk drive
and notify you when it is safe to remove the
volume.
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Mounting FireWire Disk Drives to
Macintosh Computer Systems

Note: Even if your FireWire disk drive was
bought for use on a Macintosh, you MUST first
partition and format the drive as a FAT32 volume
on FireStore (see page 30) for it to work.

On a Macintosh, start your computer and
simply connect your FireWire disk drive

to the computer utilizing a standard 6-pin to
6-pin FireWire cable. Consult your FireWire
disk drive documentation for more information.
Ensure the required FireWire disk drive drivers
have also been loaded onto you computer
system (consult your FireWire disk

drive’s documentation for more information).

When mounted, your FireWire disk drive
should appear on the computer’s desktop:

The FireStore formatted disk drive will appear
as a FAT32 volume and hence have a PC label.
This is not always the case on OS10 however.
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Once you have located your FireWire disk drive
on the desktop, double click the disk icon to
open it up. Once opened, you will see the
following:
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Dismounting FireWire Disk Drives from
Macintosh Computer Systems

Once you have completed working with your
disk drive on a Macintosh computer system,
you must first dismount the drive before
unplugging it. To do this, simply select the disk
drive on the computer’s desktop. It will

be marked with a PC symbol. Once selected,
drag the drive into the trash. This will then
dismount the particular disk drive. See Below:

FS-3 REMOTE CONTROL
COMMANDERS

Two remote control commanders are optionally
available for your FS-3. One is an infrared
commander made for use with the infrared
remote sensor on the FS-3 front panel and the
other features a 3.5mm, 15ft. cable for use
when infrared is not an option.

Before using your infrared remote commander,
ensure you have batteries installed in the unit (2
X AAA) and that the IR sensor is enabled (see
page 28 for details).

Before using the wired remote control
commander, ensure you have securely inserted
the 3.5mm mini jack to the CONTROL port on
the FS-3 rear connector panel. You will also
require batteries to use this unit (2 x AAA).

The FS-3 wired and infrared

remote commanders have the same
functionality. Buttons have the same
functionality as the similar FS-3

front panel buttons except where noted.
Remote buttons do not feature a hold to
repeat function like the front panel. Multiple
triggers must be repeatedly pressed.

They both feature the following keys

The FS-3 wired and infrared remote
commanders have the same functionality. They
both feature the following keys

STOP

RECORD
BACKWARD SEARCH
FORWARD SEARCH
PLAY

BACK INDEX
FORWARD INDEX

KEEPER -this is the same as the KEEPER
function on the FS-3 front panel
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NUMERIC KEYPAD (0-9): when using the
SCENE MARKING feature, use these keys to
mark clips to folders 0-9 (these may be
prenamed folders - see page 33 for details)
during record, playback or stop modes.

Wired Remote
Commander
Keypad Layout
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TECHNICAL SPECIFICATIONS

Input/Outputs
» DV Video /0 - 25Mbl/s
(1 x 6pin IEEE- 13943)
 External HDD 1/O - up to 400Mb/s
(1 x 6pin IEEE-1394a)
« Slot Internal HDD 1/O - up to 400Mb/s
(1 x 6pin IEEE-1394a)
* GPI & RS232C Control
(1 x 3.5mm mini jack)

Power

* Battery/Camera Plate Contacts
* 4-pin XLR DC input

* 10V to 17V, 7.5W

Physical Specification
* 2.5lbs (1.1kg) w/ FSHDD-1 Disk Drive
* 41/8"x31/2" x 6 1/4"

(105mm x89mm x 159mm)

Audio/Video/Timecode Specification

* 25 Mb/s, 8-bit 4:1:1 (NTSC-DV) or 4:2:0
(PAL-DV) video (model dependent)

* SMPTE or DV embedded timecode
(Drop or Non-Drop for NTSC-DV)

o 2-ch, 16-bit (48kHz) or 4-ch, 12-bit (32kHz)
embedded digital audio

Supported DTE Technology File Formats
RawDV (.dv), AVI Type 1 (.avi), AVI Type 2
(.avi), Canopus AVI (.avi), Matrox AVI (.avi),
QuickTime (.mov) or Avid DV-OMF (.omf)

Disk Information

« Internal Disk Type (Slot): FSHDD-1
FireWire Disk Drive

« External Disk Type: User Supplied
IEEE-1394a FireWire

* Disk Format: FAT32

» FAT32 FireWire HDD compatible with
Windows 98SE, ME, 2000, XP and
Mac OS9 and 0S10

Compliance and Warranty
» CE, C-Tick and FCC

3.5mm to DB9 Serial Cable

DB9 Connector  3.5MM Jack

Pin 2 -> 2 (middle)

Pin 5 -> 3 (barrel or shaft)
Pin 3 -> 1 (tip)

NOTE: It is possible to download the latest
Serial Control Communication Specification
for FS-3 from:
http://www.focusinfo.com/support

Panel Mount 4-pin XLR Power Input

- G'Pm4

Pinl  BLACK (-)
Pin4  RED (+)
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FS-3 LCD DISPLAY AND TALLY MODES

The table below details the different LCD and tally light characteristics when used with different FS-
3 control, record, play and stop modes:

PLAY/REC MODE FS-3LCD TALLY
Stop STOP Off
Pause Il PLAY Off
Play > PLAY Off
Rec (Pause) Il REC Blink
Normal Rec (Rec) REC On
Retro Disk (Stop) L STOP Off
Retro Disk (Standby) L REC Blink
Retro Cache (Stop) C STOP Off
Retro Cache (Standby) CREC Blink
Loop Record (Stop) O STOP Off
Loop Record (Standby) O REC Blink
Loop Record (Rec) O REC On
Snap (Stop) STOP Off
Snap (Standby) I SNAP On
Snap (Rec) I SNAP On
Time Lapse (Stop) STOP Off
Time Lapse (Pause) II'TREC Blink
Time Lapse (Rec) T REC On
CONTROL TYPE FS-3LCD TALLY
AV/C* (Stop) A STOP Off
AV/C* (Rec Pause) Il A<REC TYPE> REC Blink
AV/C* (Rec) A <REC TYPE> REC On
AV/C* (Play Pause) Il A PLAY Off
AV/C* (Play) AALL Off
Syncro Slave (Pause) 'Y <REC TYPE>REC Blink
Syncro Slave (Rec) Y <REC TYPE>REC On

* AV/C is only for use when FS-3 is connected to a computer system. To control
FS-3 from a camcorder, use Syncro Slave Mode.
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